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Preface 
The Area Change Tool (ACT) was developed in response to the need for a tool 
that could be used to help design and delineate fuel and vegetation prescriptions 
as well as edit raster layers to accurately portray treatment outcomes.  These 
edited data can be used with fire behavior analysis systems such as FARSITE 
(Finney 1998) and FlamMap (Finney and others, 2006) to evaluate the 
effectiveness of proposed fuel or vegetation treatments.  However, since ACT is 
simply a geographic information system (GIS) tool, its potential applications can 
include any GIS analysis that involves: 
 

• Creating a new shapefile  
• Editing an existing shapefile  
• Converting the attributes of a shapefile into a raster 
• Combining multiple rasters into a single raster 
• Editing the value attribute table of a raster 
• Converting edited attributes into a new raster 
• Merging an edited raster layer into the original raster layer to create 

a new layer that incorporates the edits  
 
Version 3.0.0 of the Area Change Tool was released in October, 2007.  Future 
versions may incorporate additional features, so be sure to check the NIFTT 
website at www.niftt.gov for tool updates and enhancements as well as 
associated updates to this user’s guide. 
 
 

What’s new in version 3.0.0? 
 
Earlier versions of the Area Change Tool contained two user interfaces:  a 
Wizard and Toolbar Interface.  The Toolbar Interface has been eliminated to 
streamline use and to reduce complexity.   
 
Some of the terminology used in the ACT dialog boxes has been changed with 
version 3.0.0 for added clarity. 
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Prerequisites 
 
Because ACT uses ArcGIS, as well as Microsoft Windows, Excel, and Access, a 
basic understanding of these programs is necessary for successful use of the 
Area Change Tool. 
 
Specific computer requirements for operating the Area Change Tool are 
described in Chapter 1 of this user’s guide. 
 
 

Obtaining copies 
 
To obtain additional copies of the Area Change Tool User’s Guide or the Area 
Change Tool Tutorial, follow these steps: 
  

1. Go to www.niftt.gov  
2. Under NIFTT Quick Links at the left side of the page, click on 

NIFTT Tools and User Documents.   
3. At the center of the page under NIFTT Tools and User Documents, 

click on NIFTT User Documents. 
4. Click on the material you wish to download (User’s Guide or 

Tutorial).  
 
Obtain the Area Change Tool Help Utility, ACT Installation Notes, or the latest 
version of the Area Change Tool, as follows: 
 

1. Go to www.niftt.gov  
2. Under NIFTT Quick Links at the left side of the page, click on 

NIFTT Tools and User Documents.   
3. At the center of the page under NIFTT Tools and User Documents, 

click on NIFTT Tools. 
4. Click on the material you would like to download (Help Utility, 

Installation Notes, or the latest version of the Area Change Tool). 
 
 

Credits 
 
ACT was developed for the National Interagency Fuels Technology Team 
(NIFTT) by Lee Hutter of Systems for Environmental Management (SEM), 
Missoula, Montana. Direction was provided by Jeff Jones and Wendel Hann from 
the USDA Forest Service and Marc Levesque of Acadia West, Silver City, New 
Mexico.  
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Support for the development of ACT was provided by the USDA Forest Service 
and the U.S. Department of Interior.   
 
This Area Change Tool User’s Guide was written by Jeff Jones of the USDA 
Forest Service and Deb Tirmenstein of Systems for Environmental Management. 
 
Lastly, we thank Christine Frame of Systems for Environmental Management for 
her editorial proficiency.   
 

 

Your input 
 
We value your input.  Please forward any questions, comments, reports of bugs, 
or ideas to the National Interagency Fuels Technology Team (NIFTT) at 
helpdesk@niftt.gov. 
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Chapter 1:  About the Area Change Tool 
(ACT) User’s Guide 
 
 
1.1 Before you begin 
1.2 How to use this guide 
1.3 Computer requirements 
 

1.1 Before you begin 
 
ACT users must be familiar with Microsoft Windows and have at least a basic 
understanding of ArcGIS, including a working knowledge of ArcMap and the 
Spatial Analyst extension.  If ACT is used for editing raster data, users must be 
capable of editing data in either Microsoft Excel or Microsoft Access.  For 
additional information on using ArcGIS, refer to its help utility.   
 
 

1.2 How to use this guide 
 
It is not necessary to read the entire guide from beginning to end to carry out a 
specific task using ACT.  Once you are familiar with the basic concepts, you can 
quickly locate common functions by referring to headings in the Table of 
Contents.  You can then go to the specific section that addresses your needs.  
Whenever possible, screen captures are used to illustrate necessary steps.   
 
The Area Change Tool User’s Guide is not intended to provide step-by-step 
guidance on the tool’s operation; rather, it is intended to serve as a reference 
guide.  The Area Change Tool Tutorial available at www.niftt.gov provides basic 
step-by-step instructions. 
 

1.3 Computer requirements 
 
Ensure the following programs are installed and functioning properly on your 
computer: 
 

• ArcGIS 9.2 
• Spatial Analyst extension of ArcGIS 9.2 
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• Microsoft Excel (2000 or higher) 
• Microsoft Access (2000 or higher) 

 
 
Although system requirements to run ArcGIS 9.2 will suffice to run NIFTT tools, 
at least 10 GB of free hard drive space and 2 GB of RAM are recommended.  
Generally, faster processors, more memory, and increased free hard drive space 
will improve performance.  In addition, NIFTT tools were developed for Windows 
Operating Systems. 
 
 

Note: Make sure that you have sufficient space and adequate permissions 
for storing Area Change Tool outputs on your computer. 

 
 

Note: Make sure that the Area Change Tool version you are using 
correctly matches the version of ArcGIS on your computer.  Use Area 
Change Tool Version 3.0.0 only with ArcGIS 9.2.  Area Change Tool 
version 2.0.3 is compatible with ArcGIS 9.0 or 9.1. 
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Chapter 2:  ACT Function 
  
2.1 What does ACT do? 
2.2 Applications of ACT 
2.3 How does ACT work? 
 
 

2.1 What does ACT do? 
 
ACT is a GIS tool that facilitates combining and editing raster data using ArcMap.  
It completes these tasks from the ArcMap platform and uses Microsoft Excel or 
Access to edit the attribute tables of raster layers.  Moreover, ACT allows you to 
maintain logical relationships between raster layers by combining them first into a 
single layer so that multiple attributes can then be edited simultaneously.   
 
ACT incorporates seven GIS functions that are commonly used for editing raster 
data.  These include: 
 

• Delineating new shapefiles (for example, identifying a project 
boundary) 

• Editing shapefiles (for example, identifying various treatment units 
within a project boundary) 

• Converting shapefile attributes to raster layers 
• Combining multiple rasters into a single layer 
• Editing the Value Attribute Table of a combined raster  
• Creating a new raster layer from an attribute of an existing raster 

layer 
• Merging edited values back into the original raster layer 

 
 

2.2 Applications of ACT 
 
In general, ACT is useful for GIS applications that involve:  
 

• Editing incorrect raster layers  
• Updating raster layers to reflect recent disturbances such as 

wildland fire, insects, disease, or weather 
• Changing raster layers to reflect post-treatment outcomes  
• Characterizing conditions at the pixel level based on multiple 

attributes 
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• Deriving a new thematic layer based on a combination of multiple 
existing layers 

• Prioritizing treatment areas on the basis of layers created from a 
combination of attributes 

 
 
Data layers such as biophysical settings, vegetation, and fuels are used as input 
into models across relatively large geographic areas.  Users frequently modify 
these layers by refining them at a more local level.  However, the process of 
editing raster layers can prove complicated.  Even less-experienced users will be 
able to modify raster layers using the Area Change Tool.  For instance, a fire 
behavior analyst may believe that an existing fuel model layer is limiting the 
ability to simulate observed fire behavior.  The analyst can use ACT to modify the 
existing fuel model layer to more closely simulate actual observed fire behavior.   
 
Ecosystems are dynamic, necessitating frequent updates to data.  Wildland fires, 
wind storms, floods, insects, disease, and human-caused activities are constantly 
modifying vegetation structure and composition as well as landscape patterns.  
Data layers need to be updated on a continual basis to reflect changing 
conditions.  Data can be updated to reflect post-disturbance conditions by using 
the ACT in combination with disturbance layers such as burn severity data. 
 
ACT can be used to evaluate the effectiveness of proposed vegetation and fuel 
treatment prescriptions in meeting management objectives.  Raster layers can be 
changed so that they portray proposed treatment outcomes.  These edited layers 
can then be fed into modeling systems that predict potential fire behavior, wildlife 
habitat, ecosystem departure, or other layers of interest.   
 
The Area Change Tool can help users derive or model a new thematic layer 
based on some combination of existing layers.  By combining multiple raster 
layers into a single layer, data can be integrated at the pixel level.  GIS modelers 
commonly produce a layer or theme based on the combination of a suite of 
layers.  For example, some wildlife habitat layers may be derived on the basis of 
a spatial coincidence of elevation, aspect, cover type, diameter class, and 
canopy cover.  ACT can be used to combine these layers and, subsequently, to 
classify the habitat of interest.  
 
The integration of a suite of variables at the pixel level allows for rapid diagnosis 
of concerns, identification of opportunities, and development of general 
prescriptions.  As many as 20 rasters can be combined to generate a Value 
Attribute Table in which each record (value) represents a unique combination of 
the input layers.  Having information on up to 20 layers represented on every 
given pixel can be powerful.  For instance, ACT can be used to characterize each 
pixel by biophysical setting, existing vegetation (cover type, size class, or canopy 
cover), existing fuels (fire behavior fuel model, canopy base height, canopy 
height, or canopy bulk density), and likely fire behavior given some combination 
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of environmental parameters (for example, fuel moisture and wind).  The 
combined layer can then be used to identify treatment opportunities and can 
assist in designing treatment prescriptions. 
 
ACT provides a means to edit the values of multiple layers simultaneously, 
thereby maintaining logical relationships between the layers.   Predicting fire 
behavior using FlamMap (Finney and others 2006) and FARSITE (Finney 1998) 
requires a landscape area defined by the combination of elevation, slope, aspect, 
fire behavior fuel model, canopy base height, canopy height, and canopy cover.  
Fire behavior is then predicted on the basis of these combined layers.  Since 
several of these themes are interrelated, it may be important to retain logical 
relationships among them.  Therefore, if a user wants to model fire behavior but 
believes that the fire behavior fuel model layer needs refinement, it may be 
necessary to modify the canopy cover, canopy base height, and canopy bulk 
density layers so that they are logically consistent with the fuel model layer.  In 
other words, a change in one variable, for example fire behavior fuel model, may 
require changes to other related variables such as cover type, size class, canopy 
base height, canopy cover, and canopy bulk density.   
 
ACT can be used to develop spatial priorities by identifying areas where a 
combination of conditions occur.  For example, fuel treatment polygons can be 
delineated around areas where passive or active crown fire would be likely in 
conjunction with specific fire behavior fuel models, canopy base height values, 
and canopy cover values.  If managers are limited to using mechanized 
equipment to treat fuels and vegetation, the selection criteria could be further 
limited using thematic layers denoting slope and distance to open roads. 
 
 

2.3 How does ACT work? 
 
ACT guides the user through a sequential process for delineating vegetation and 
fuel treatment polygons, combining raster data layers that may need to be 
changed to reflect treatment objectives, editing the Value Attribute Table to 
reflect treatment outcomes, and creating new updated raster layers.  Although 
the Area Change Tool uses a linear process that links multiple GIS processing 
steps together, that process need not be followed.  Any of the GIS tasks can be 
selected at any time.   
 
ACT contains two options for changing raster layers: Uniform Change and 
Variable Change.  The Uniform Change is used when all values of a given layer 
within a polygon are changed to a single value (fig. 2-1).  The Variable Change 
option is used when the desired edits would result in multiple values within a 
polygon (fig. 2-2).  For example, suppose you have an existing fire behavior fuel 
model layer that follows Anderson (1982).  After the fuel model layer was 
produced, you were provided with a detailed map of exotic annual grasses that 



Area Change Tool User’s Guide        Chapter 2 

 12

you believe should be classified as FBFM-1 (Short Grass Model).  Consequently, 
you want to change all of the values in the existing fuel model layer that coincide 
with the polygons denoting exotic annual grasses to FBFM-1.  In this example, 
these edits could be made easily using ACT’s Uniform Change option since only 
one value is being assigned to the polygons (fig. 2-1).  However, if you want to 
update a fuel model layer after a wildland fire on the basis of three classes of 
burn severity (for example, low, moderate, and high), then the Variable Change 
option could be used to assign different fuel models on the basis of pre-burn 
conditions and burn severity class (fig. 2-2). 
 
 

 
 
Figure 2-1. Using the Uniform Change option to change fire behavior fuel models based on areas 
mapped as exotic annual grasses. 
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Figure 2-2. Using the Variable Change option to update a fuel model layer based on burn severity 
data. 

 
 
ACT includes two options for editing a raster layer’s attribute table when the 
Variable Change option is selected.  Microsoft Excel can be used to edit 
relatively small or homogeneous areas when the number of unique values or 
records is low.  However, combining multiple raster layers into a single layer may 
result in a Value Attribute Table with several thousand unique values.   Using 
Excel to edit a table of this size can be very tedious.  For these situations, edits 
can often be made more efficiently by using Microsoft Access, which uses 
queries to change hundreds of records simultaneously. 
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Chapter 3:  Installing the Area Change 
Tool 
 
 
3.1 General installation instructions 
3.2 Area Change Tool installation 

3.2.1 Downloading the Area Change Tool 
3.2.2 Beginning the installation process 
3.2.3 The .NET framework 
3.2.4 Finishing installation 

3.3 Troubleshooting Area Change Tool installation 
 
 

3.1 General installation instructions 
 
All NIFTT tools, including the Area Change Tool, are now downloaded and 
installed as single tools.  A complete or package install is no longer available for 
versions of NIFTT tools compatible with ArcMap 9.2. 
 

Note:  For the Area Change Tool version 3.0.0 to operate properly, you 
will need to verify that you are using ArcGIS 9.2. 

 
If you have an earlier version of the Area Change Tool installed on your 
computer, you will first need to uninstall it before proceeding with 
installation of the current version.    
 
To determine which version is currently installed on your computer, go to Start > 
Control Panel > Add or Remove Programs as shown below: 
 

 
 
Figure 3- 1. Area Change Tool version 3.0.0. 
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Note:  NIFTT naming conventions are as follows:  ACT_ 220_071113 
indicates that this “install” is version 2.2.0 and was completed on 
11/13/2007. 

  
You may need administrative privileges to install the Area Change Tool.  Contact 
your system administrator if you experience problems with the installation. 
 

3.2 Area Change Tool installation 
 

 3.2.1 Downloading the Area Change Tool 

 
If you would like to install or reinstall the Area Change Tool follow these 
steps: 

 
Note:  If you have an earlier version of the ACT installed on your 
computer, you will first need to uninstall it before proceeding with 
installation of the current version.  Refer to section 3.1 for more 
information on this subject. 

 
Download ACT from www.niftt.gov.  Go to NIFTT > Downloads located at 
the left side of the page. 

 

 
Figure 3- 2.  Select Downloads. 
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Click on the ACT Install File from the table as shown below to begin the 
download. 
 

 
Figure 3- 3.  Click on the ACT Install File. 

 
 

Note:  To continue with the download, you will need to have WinZip or a 
similar program installed on your computer. 

 
Click OK or Save File to download the self-extracting WinZip ACT 
installation file and then save it to a convenient location on your computer.   

 
 

 
Figure 3- 4.  Download and save installation file. 

 
 

 3.2.2 Beginning the installation process 

 
Go to the file in which you stored the Area Change Tool zip file and right 
click on the file name.  Select the option Extract to folder and choose 
either the default location (C:\NIFTT as shown in figure 3-5) or another 
location of your choice. 
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Figure 3- 5.  Self-extracting ACT installation file has been downloaded and saved. 

 
Next, navigate to the directory in which you have saved your extracted 
Area Change Tool files.   

 
Note:  Do not install the Area Change Tool or any other NIFTT tool to a 
path that may contain a space in the folder name such as “My Documents” 
or “Program Files.” 

 

 
Figure 3- 6.  Area Change Tool installation files. 

 
 

Click on setup.exe. 
 

Note:  If the setup determines that an earlier version of the ACT is already 
installed on your computer, go to Start > Control Panel and select 
Add/Remove Programs.  Uninstall the previous version of the Area 
Change Tool and then rerun setup.exe.   

 
If the setup.exe determines that you already have the proper .NET 
Framework (2.0) installed on your computer, the Area Change Tool zip file 
contains everything that you will need for installation.   A series of dialog 
boxes will now open.  Skip to section 3.2.4 to continue installation. 

 

 3.2.3 Obtaining the latest .NET Framework 

If the installer determines that the setup requires a .NET Framework that 
has not been previously installed on your computer, you will see a dialog 
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box similar to figure 3-7 instead of the first screen of the Area Change 
Tool Setup Wizard as shown in figure 3-14. 

 
 

 
Figure 3-7.  Dialog box indicating the need to first install .NET Framework for installation to 
proceed. 

 
Click on Yes and follow all prompts as directed.  If the .NET Framework 
2.0 has not been previously installed on your computer, the setup will, at 
this point, direct you to a website where you will be able to download the 
appropriate file (See fig. 3-8). 

 

 
Figure 3-8.  Website for downloading .NET Framework 2.0. 

 
As shown in figure 3-9, you will need to specify which version of .NET 
Framework you would like to install on your computer.   Select the x86 
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version if you have a Pentium (or other 32-bit) computer.  Click on 
Download x86 version. 

 
Tip:  Most users will need to specify the x86 version of NET Framework 
2.0. If you are unsure, contact your system administrator.   

 
Figure 3- 9.  Select the correct version of .NET Framework. 

 
A screen similar to the following will appear after your selection has been 
made.  Click on the Download button to continue. 

 
 

 
Figure 3-10.  Microsoft .NET Framework Version 2.0 (x86) download page. 
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Browse to a location of your choice.  Download and save the dotnetx.exe 
file as shown in figure 3-11. 

 

 
Figure 3-11.  Save the file to a location of your choice. 

 

 
Figure 3-12.  Progress bar indicating dotnetfx.exe download. 

 
The Microsoft .NET framework 2.0 will download, extract and install 
automatically as shown in figures 3-12 and 3-13. 
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Figure 3-13.  .NET Framework installation 

 
Click on the setup.exe file as shown in Figure 3-6 to initiate the setup 
wizard and to continue installation of the Area Change Tool. 

 
At this point, you may need administrative privileges to continue.  Contact 
your system administrator if you experience problems. 

 
  

 3.2.4 Finishing installation 

 
After clicking on the setup.exe file, the first in a series of Area Change 
Tool Setup Wizard dialog boxes will open.  Follow instructions as directed 
by the dialog boxes in the Setup Wizard.  During the installation process 
you may see a radio button asking you to specify whether the tool is to be 
installed for “Everyone” or “Just Me.”  Select the “Everyone” option.   

 

 
Figure 3- 14.  First dialog box of the Area Change Tool setup wizard. 
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Figure 3- 15.  Setup Wizard continues installation. 

 
 

Click on Finish when the Area Change Tool installation is complete. 
 

Open ArcMap and make sure that the Area Change Tool Toolbar    is 
visible. 

 
 

Note:  The toolbar may be “floating” and if so, you will need to anchor it in 
a convenient location. 

 
 

Tip:  For best results, make sure that you have installed the most recent 
ArcGIS service packs and patches.  Go to www.esri.com to verify that you 
have the most recent versions for 9.2 already installed on your computer.  
If you do not, download the newer service packs and patches as directed 
on the website. 
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3.3 Troubleshooting ACT installation 
 
 

Note:  Be sure that you do not have an earlier version of ACT installed on 
your computer before downloading any newer version of the product. 

 
 

If the ACT Toolbar shown at right   does not appear automatically when you 
open ArcMap, select View > Toolbars and check the box to the left of Area 
Change Tool 3.0.0, if it is not already checked (fig. 3-16). 
 

 
Figure 3-16. Verifying that the Area Change Tool 3.0.0 is checked. 

 
If you are still unable to view the ACT Toolbar, or if the Area Change Tool does 
not appear in the list, click on the Tools menu and select Customize.  Make sure 
that both the Area Change Tool 3.0.0 and Spatial Analyst are checked and click 
on Close (fig. 3-17).   
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Tip:  Just because you can view a Spatial Analyst Toolbar in ArcMap 
doesn’t necessarily mean that the tool is installed and operational.  You 
can verify that it is turned on by selecting Tools > Extensions. If Spatial 
Analyst is listed but not checked, check it now; if it is not listed, then you 
will need to obtain it now. 

 

 
Figure 3-17. The Customize dialog box. 

 
 
In ArcMap, again select the View menu and click on Toolbars.  Verify that the 
Area Change Tool 3.0.0 is listed and checked and make sure that the Spatial 
Analyst Toolbar is installed and turned on.   
 
 

Note:  If you have any additional questions about tool installation, please 
contact the helpdesk at: helpdesk@niftt.gov.   
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Chapter 4:  Using the Area Change Tool 
 
 
4.1 Using the Area Change Tool 
4.2 Starting ACT 
4.3 Setting the editing task  
4.4 Uniform Change editing 

4.4.1 GIS functions 
4.4.2 Creating a new shapefile 
4.4.3 Editing an existing shapefile 
4.4.4 Converting shapefile attributes to new rasters  
4.4.5 Merging edited rasters with original rasters 

4.5 Variable Change editing 
4.5.1 GIS functions 
4.5.2 Creating a new shapefile 
4.5.3 Editing an existing shapefile 
4.5.4 Converting shapefile attributes to rasters 
4.5.5 Combining rasters 
4.5.6 Editing raster attribute tables 
4.5.7 Converting raster attributes to rasters 
4.5.8 Merging edited rasters with original rasters 

 
 

4.1 Using the Area Change Tool 
 
ACT guides the user through a sequential process for delineating vegetation and 
fuel treatment polygons, combining raster data layers that need to be changed to 
reflect treatment objectives, editing the Value Attribute Table to reflect treatment 
outcomes, and creating new raster layers that depict treatment outcomes.  
Although ACT uses a linear process to link multiple GIS processing steps 
together, that sequential process need not be followed or completed.  Instead, 
any of ACT’s GIS tasks can be selected in any order, or used completely 
independently of each other.   
 
ACT uses a suite of user-friendly dialog boxes to complete GIS processing.  
Each dialog box includes an overview as well as tool tips to help the user 
navigate within the box itself (fig. 4-1). 
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Figure 4-1. Overview and Navigation tips. 

 
 

4.2 Starting ACT 
 
Because ACT operates from an ArcGIS platform, ArcMap must be opened before 
ACT can be initiated.  A toolbar consisting of a single icon should be visible after 
you open an ArcMap project (fig. 4-2).  
 
 

 
Figure 4-2. The ACT Toolbar. 

 
 

1. First start ArcMap and create a new project by selecting A new 
empty map as shown in figure 4-3: 
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Figure 4-3. Creating a new project in ArcMap. 

 
 

2. Next, load input layers into your ArcMap project by clicking on the 
Add Data icon (fig. 4.4): 

 

 
 
Figure 4-4. Loading input layers. 

 
 
 

3. Navigate to the directory where your data layers are stored and add 
input layers. 
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Tip:  At this point, you may see several “Create pyramids” dialog boxes 
similar to the box shown in figure 4-5.  Click No to speed up processing.   
If you do not want to see this box again, put a check in the lower left-hand 
corner to disable it. 

 

 
Figure 4-5.  Create pyramids dialog box. 

 
 

4. Click on the ACT Toolbar (fig. 4-2) to open the main dialog box (fig. 
4-6).  All applications of ACT must begin with the Area Change Tool 
dialog box, which is used to specify the Editing Task, to identify 
where to store outputs, and to select the GIS task to be performed.   

 

 
Figure 4-6. Selecting the Editing Task. 
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4.3 Setting the editing task  
 
Two types of editing can be accomplished using ACT.  The Uniform Change 
option will alter all raster values within a polygon to a single value that is 
specified by the user (in other words, a many-to-one change).  The Variable 
Change option allows you to change raster values within a polygon to many 
different values.  It represents a non-uniform change in which you can define 
rules that will include multiple changes to many attributes (or, a many-to-many 
change).  This option can also include changes to multiple data layers. 
 
A Uniform Change might include creating a treatment area that would change 
one or more grid values to a single value.  For example, a prescribed fire might 
change the fire behavior fuel model, canopy base height, and canopy cover so 
that each is represented by a single value (for example,  FBFM 2; 15-feet canopy 
base height, and 30 percent canopy cover).  All other values outside of the burn 
perimeter would remain unchanged.   
 
Uniform Change edits are generally useful only when dealing with very 
homogenous environments.  However, vegetation and fuel prescriptions typically 
vary according to complex conditions (slope, aspect, biophysical setting, cover 
type, size class, canopy cover, surface fuels, and canopy fuels) or according to 
management objectives (such as habitat objectives, visual objectives, or air 
quality objectives).  The Variable Change editing process is generally most useful 
for real-world GIS challenges. 
 
A Variable Change involves altering many different values within a polygon to 
many other values.  Typically, the values to be changed are assigned on the 
basis of a combination of attributes.  For example, since fire behavior varies with 
weather, fuels, and topography, it is not surprising that fuel treatment 
prescriptions might vary according to attributes such as slope, aspect, elevation, 
surface fuels, and canopy fuels. 
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4.4 Uniform Change editing 
  
Remember that the objective of the Uniform Change is to change all of the 
current values of one or more layers that intersect a polygon to a single value.   
 

Note: Skip to Variable Change editing if you are interested in changing 
raster values in a polygon to many different values (a “many-to-many 
change”). 

 
The following describes how to edit data using the Uniform Change option. 
 

1. Select the Uniform Change radio button as shown (fig. 4-6). 
 

2. Enter a name of your choice in the Project Name window (fig. 4-7).  
(This step is optional). 

 
3. Next specify a Project Path by clicking on the browse button to 

navigate to a folder where outputs are stored.  (This step is 
required).   

 
ACT will automatically fill in the Project will be saved at window if a name and a 
path was specified for the project.  If a Project Name was not selected, no 
information will appear.  It is not necessary to enter any information.  
 

Tip:  Once a project path or location for the project to be stored is entered, 
it cannot be edited.  Therefore, if you make an error, you will need to start 
over with this dialog box. 

 



Area Change Tool User’s Guide        Chapter 4 

 31

 
 
Figure 4-7. Providing inputs to the Area Change Tool dialog box. 

 
 

 4.4.1 GIS functions 

 
The following GIS functions are available when the Uniform Change 
option is selected:  

 
• Create a new shapefile – The shapefile is used to delineate 

polygons where edits are to occur.  When this option is selected, 
the Next button will take you to the New Shapefile interface. 

 
• Edit an existing shapefile – The Next button will close ACT and 

open ESRI’s Editor Toolbar which can be used to modify an 
existing shapefile.  When edits are complete, once again select the 
Area Change Tool dialog box to continue.   

 
• Convert shapefile attributes to rasters – When this option is 

selected, clicking on the Next button opens the Shapefile Attributes 
to New Rasters dialog box.  This allows you to convert any 
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numerical attribute contained within the shapefile to a new raster 
layer. 

 
• Merge edited rasters with original rasters – When this utility is 

selected, the Next button opens the Merge Edited Rasters dialog 
box, which is used to “burn-in” the values from an edited layer into 
the original layer.  Thus, a new layer is created by adding the edited 
values to the original values. 

 
 

 4.4.2 Creating a new shapefile 

 
Creating a new shapefile involves drawing polygons and providing 
attributes for these polygons.   

 
1. Select the radio button Create New Shapefile in the GIS Function 

box shown in figure 4-8. This feature allows you to create an empty 
shapefile having either default or user-defined attributes that can be 
edited.   

 

 
 
Figure 4-8. Using ACT to create a new shapefile. 
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2. Click Next to open the New Shapefile dialog box.  This dialog box 
is used to name the shapefile and to identify any attributes to be 
included in the shapefile.  Attributes should be added to the 
shapefile if values in the original raster layer may be changed. 

 

 
 
Figure 4-9. The New Shapefile dialog box. 

 
 

3. Enter a name for the shapefile in the New Shapefile dialog box as 
shown (fig. 4-9).  Remember that you do not need to add an 
extension, and the name is limited to eight characters or less.  In 
addition, the file name you select should not contain any spaces, 
leading numbers, or special characters (`~! @#$^()-+={ }[ ]|\?/:;”’< 
>,.). 

   
 

Any attribute can be added to the shapefile by clicking Add New Attribute 
and entering a Name, Data Type, Length, and Precision (number of 
decimal places).  If the shapefile contains multiple polygons, we 
recommend including an identifier as an attribute to keep track of the 
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specific polygons.  Notice that ACT can add default attributes to the 
shapefile, if desired.  Simply check the Uniform Change - Default 
Attributes box.  The default attributes were established for those interested 
in editing surface and canopy fuel and succession class layers, which are 
used to derive fire regime condition class (fig. 4-10).  The default attributes 
are shown in table 4-1. 
 

Table 4-1. Default attributes available for the Uniform Change option. 

Attribute Name Attribute Description 
Id Polygon identifier 
S-Class Succession class 
FBFM Fire behavior fuel model 
CC Canopy cover 
CH Canopy height 
CBH Canopy base height 
CBD Canopy bulk density 
 
 

 
Figure 4-10. Selecting the default attributes for a Uniform Change.  

 
 

4. Check the box to the left of the attribute name after adding all of the 
attributes to be edited.  Only those attributes that have been 
checked will be included in the shapefile.  Simply check or uncheck 
selections to add or remove them from your new shapefile.   

 



Area Change Tool User’s Guide        Chapter 4 

 35

Tip:  The “Data Type” drop-down menu allows you to select “Long 
Integer,” “String,” etc., or you can accept the default values.  The “Length” 
field gives the expected number of characters in a string and the 
“Precision” field specifies the number of decimal places. 

 
The data format can be modified as needed.  Refer to ArcGIS Help for 
further information on data type. 

 
5. Click Next when the dialog box is complete to open the Editor 

Toolbar and close ACT.    
 
 

 4.4.3 Editing an existing shapefile 

 
1. Select the Edit Existing Shapefile radio button in the GIS Function 

box if you want to edit an existing shapefile rather than create a 
new shapefile from scratch (fig. 4-11).  

 
 

 
Figure 4-11. Selecting the Edit Existing Shapefile GIS Function from the Area Change Tool dialog 
box. 
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2. Click Next to open the Editor Toolbar. The Editor Toolbar used by 
ACT (fig. 4-12) is the same as the Editor Toolbar available in 
ArcMap and is used to create or edit shapefiles.    

 
 

 
Figure 4-12. Editor Toolbar and Editor drop-down menu. 

 
 

Tip:  When editing is complete, return to the Area Change Tool by clicking 
on the ACT Toolbar. 

 
3. Click on the Editor drop-down list and select Start Editing as 

shown in figure 4-12.  Select the path that contains the target 
shapefile.  A Start Editing dialog box, which is used to select the 
appropriate path containing the shapefile to be edited, will appear 
(fig. 4-13) 
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Figure 4-13. The Start Editing dialog box indicates layers available for editing. 

 
 
 

4. After identifying the path, select an editing task from the Task drop-
down menu on the Editor Toolbar (fig. 4-14).  

  

 
Figure 4-14. Editor Toolbar showing the Sketch Tool, Task, and Target drop-down menus with 
the shapefile “TreatmentA” selected. 

 
5. Select Create New Feature if your objective is to add polygons.  

Select Reshape Feature if your objective is to change the shape of 
existing polygons.  If your objective is to modify values in the 
attribute table, simply open the attribute table and change the 
values. 
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6. Finally you will need to select the appropriate shapefile from the 
Target drop-down menu on the Editor Toolbar. 

 
7. Click on the Sketch Tool icon and begin drawing a polygon.  

Consult ArcMap’s Help utility for more information on creating and 
editing polygons.  We recommend that you save your edits 
frequently (for example, after you have completed each polygon).  
When you have finished drawing all polygons within your shapefile, 
be sure to select Save Edits. 

 
Tip:  If you happen to make a mistake in your drawing, it may be easier to 
delete the polygon and start over rather than trying to edit an existing 
polygon. 

 
8. Next, you need to provide appropriate values for the attributes 

within the shapefile.  Open the attribute table of the shapefile you 
have created by right clicking on the new shapefile in ArcMap’s 
Table of Contents and select Open Attribute Table (fig. 4-15). 

 
 

 
Figure 4-15. Example attribute table of a shapefile with four polygons containing the following 
attributes: Id = polygon identifier, S-Class = succession class, FBFM = fire behavior fuel model, 
CC = canopy cover, CH = canopy height, CBH = canopy base height, and CBD = canopy bulk 
density. 

 
 

9. Enter the values that you wish to use in the appropriate cells of 
your attribute table.  When finished, select Editor > Stop Editing 
and follow the prompt to save your work.  Close the Editor Toolbar 
and the attribute table. 

 
Tip:  Be sure to press Enter after adding the last value and then close the 
attribute table before continuing. 

 
 

10. When finished editing, select Editor > Stop Editing and follow the 
prompt to save your work.  Close the Editor Toolbar and the 
attribute table. 
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Figure 4-16.  Stop editing. 

 

 4.4.4 Converting shapefile attributes to rasters 

 
The next step in the Uniform Change process is to convert a shapefile’s 
attributes of interest to new raster layers.  The GIS function Convert 
Shapefile Attributes to Rasters enables the user to convert every attribute 
of a shapefile to a new raster layer.    

 
1. Re-start ACT by clicking on the toolbar. 

 
2. ACT will automatically open to the Convert Shapefile Attributes to 

Rasters dialog box.  Click Next (fig. 4-17). 
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Figure 4-17. Selecting Convert Shapefile Attributes to Rasters function. 

 
3. The following dialog box will open (fig. 4-18): 
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Figure 4-18. Shapefile Attributes to New Rasters dialog box.  In this example, the shapefile 
contains seven attributes: Id = polygon identifier, S-Class = succession class, FBFM = fire 
behavior fuel model, CC = canopy cover, CH = canopy height, CBH = canopy base height and 
CBD = canopy bulk density. 

 
 

Note: The target shapefile must be present in ArcMap’s Table of Contents 
before its attributes can be converted to new rasters. 

 
4. Select the shapefile containing the attributes to be converted to 

rasters by using the drop-down menu near the top of the dialog box 
(fig. 4-18).  Enter a name for each new raster by double-clicking in 
the box under New Raster Name.  Once you have entered a new 
raster name, the box to the left of each attribute’s name is enabled, 
and you can check the attributes you want to convert.  Only 
attributes that are checked will be converted to a new raster. 

 
 

Note:  Remember that you do not need to add an extension, and the 
name is limited to eight characters or less.  In addition, the file name you 
select should not contain any spaces, leading numbers, or special 
characters (`~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 

 
Tip:  You will not be able to check boxes in the “Shapefile Attributes” 
window until you double-click in the corresponding “New Raster Name” 
cell and enter a name. 
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5. If you have chosen a Project, the path will be automatically 

selected.  Click Next to begin the conversion process.  The new 
raster layers will automatically be added to the ArcMap Table of 
Contents.   

 
Note: A progress bar located at the bottom of the dialog box indicates that 
conversion is proceeding.    

 
 

 4.4.5 Merging edited rasters with original rasters 

 
The last step in the Uniform Change process is to merge the newly 
created rasters into the original or target rasters, thereby creating a new 
raster that covers the full extent of the analysis area and that reflects the 
completed edits. 

 
1. First make sure that the Edited Rasters and Target Rasters are 

available in your ArcMap project.  Only those layers shown in the 
Table of Contents will be available for you to select in the Merge 
Change Raster dialog box.   

 
2. ACT will automatically open the Merge Edited Rasters with Original 

Rasters dialog box (fig. 4-19) to merge the Edited and Target 
rasters.   
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Figure 4-19. Selecting the Merge Edited Rasters with Original Rasters function from the Area 
Change Tool dialog box. 

 
3. Click Next to open the following Merge Rasters dialog box: 
 

 
Figure 4-20. The Merge Rasters dialog box identifies the rasters and attributes to be merged. 
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The Merge Rasters dialog box (fig. 4-20) requires the following: 
 

• Edited Raster – The raster created from the shapefile containing 
the edited information.  The list of available rasters includes any 
raster currently in the ArcMap Table of Contents.  The Edited 
Raster is merged into the original or target raster.  

• Edited Raster Attribute – The attribute in the Edited Raster that will 
be used to overwrite the corresponding attribute from the original or 
target raster. The drop-down menu includes all attributes in the 
Edited Raster. 

• Target Raster – The original or target raster that will be merged 
with the Edited Raster.  The drop-down menu includes any raster 
that appears in the ArcMap Table of Contents. 

• Target Raster Attribute – The attribute from the target raster that 
will be overwritten by the attribute from the Edited Raster. 

• Merged Raster Name – The new raster created by merging the 
edited and original rasters together. 

 
4. Highlight the row containing an Edited Raster that you wish to use 

to overwrite an existing raster.  Press the Enter key to move your 
cursor to the next column labeled Edited Raster Attribute.  The 
drop-down menu includes all attributes in the Edited Raster.   

 
5. Next, select the appropriate attribute and use Enter to advance the 

cursor to the next column (Target Raster).  Select the target raster 
from a drop-down menu that includes every raster in the ArcMap 
Table of Contents.   Again, press Enter to advance your cursor to 
the next column (Target Raster Attribute).  Select the attribute of 
the target raster that will be overwritten by the Edited Raster.  Use 
Enter to advance your cursor to the last column (Merged Raster 
Name) of the dialog box.   

 
6. Enter a name for the new raster that will result from merging the 

Edited Raster with the Target Raster.  Lastly, place a check in the 
box associated with the Edited Raster in the first column.   

 
Note:  Remember that you do not need to add an extension, and the 
name is limited to eight characters or less.  In addition, the file name you 
select should not contain any spaces, leading numbers, or special 
characters (`~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 

 
If necessary, use the browse button located to the right of the Save 
Rasters to window to navigate to an appropriate folder for storing the 
newly created rasters. 
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7. Click Finish to initiate the processing of the new raster layers which 

will automatically be added to the ArcMap Table of Contents.  The 
Uniform Change process is now complete, and ACT returns to the 
first dialog box. 

 
 

Tip:  Rest your cursor on the “Navigation” button located at the upper right 
corner of the dialog box for help in moving around the “Merge Rasters” 
dialog box. 

 
 

 
 
 

4.5 Variable Change editing 
 
The Variable Change editing process involves changing pixel values in a non-
uniform manner.  Frequently, the edits are made within polygons that denote a 
target area.  However, these changes can also be made across the full extent of 
the data layer(s) without the use of polygons.  
 
 

1. Open ArcMap to start the editing process, add all layers of interest, 

and then click on the ACT Toolbar -  
 

2. The Area Change Tool dialog box will open (fig. 4-21).  Select the 
radio button in the Editing Task box to the left of Variable Change.   

 
3. Enter a Project Name (optional) and Project Path as demonstrated 

in figure 4-7.  The project name will establish a unique folder for 
storing all outputs; leave this entry empty if a unique output folder is 
not desired.   
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4.5.1 GIS functions 

 
There are seven GIS functions available when the Variable Change option 
is selected.  These include:  

 
1. Create a new shapefile – The shapefile is used to delineate 

polygons where edits are to occur.  When this option is selected, 
the Next button opens the New Shapefile dialog box. 

 
2. Edit an existing shapefile – When this option is selected, the Next 

button closes ACT and opens ESRI’s Editor Toolbar.  The Editor 
Toolbar can be used to modify an existing shapefile.  When the 
edits are complete, once again open the main Area Change Tool 
dialog box to continue.   

 
3. Convert shapefile attributes to rasters – When this option is 

selected, clicking on the Next button opens the Shapefile Attributes 
to New Rasters dialog box.  This utility allows you to convert any 
numerical attribute contained within the shapefile to a new raster 
layer. 

 
4. Combine rasters – This function is used to integrate multiple data 

layers by selecting attributes from rasters to join into a combine 
raster. Clicking on the Next button opens the Combine Rasters 
interface. 

 
5. Edit the raster attribute table – When this option is selected, clicking 

on the Next button opens the Edit Rasters Manager.  This dialog 
box can be used to transfer an attribute table to Excel, transfer 
edited data in Excel to an attribute table, transfer an attribute table 
to Access, or to transfer edited data in Access to an attribute table. 

 
6. Convert raster attributes to rasters – This option allows you to 

create individual raster layers from the attributes of a combined 
layer.  Clicking on the Next button opens the Raster Attributes to 
Rasters dialog box. 

 
7. Merge edited rasters with original rasters – When this utility is 

selected, the Next button opens the Merge Edited Rasters dialog 
box.  This function is used to “burn-in” the values from an edited 
layer into the original layer.  Thus, a new layer is created by adding 
the edited values to the original values. 
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Although ACT was designed to follow a sequence of processing steps, it is 
not necessary to follow this sequence or to complete all of the steps.  
Each of the GIS functions can be used independently as a stand-alone 
process.  For example, if you plan to make changes throughout the entire 
extent of your analysis area, there is probably no need to create a 
shapefile to constrain the changes to a limited area.  In this instance, the 
editing process might actually begin with combining a suite of rasters. 
 

 

 
Figure 4-21. Area Change Tool dialog box showing the GIS functions available when conducting 
Variable Change edits. 

 
 

 4.5.2 Creating a new shapefile 

 
The process for creating a new shapefile involves two steps.  First the 
polygons are delineated.  The second step involves attributing the 
polygons drawn in the first part of the process.   

 
1. First, select the radio button Create New Shapefile in the GIS 

Function box as shown in figure 4-22. This feature allows you to 
create an empty shapefile having either default or user-defined 
attributes that can be used during the editing session.   
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2. Click Next to open the New Shapefile dialog box as shown in figure 
4-23.  This dialog box is used to name the shapefile and to identify 
any attributes you wish to include.  Attributes should be added to 
the shapefile if you intend to change their values in the original 
raster layer. 

 

 
Figure 4-22. Using the Area Change Tool dialog box to create a new shapefile. 

 
 

3. Enter a name for your shapefile (fig. 4-23). Remember that you do 
not need to add an extension, and the name is limited to eight 
characters or less.  In addition, the file name you select should not 
contain any spaces, leading numbers, or special characters (`~! 
@#$^()-+={ }[ ]|\?/:;”’< >,.). 
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Figure 4-23. Creating a new shapefile. 

 
 

You can add any attribute to the shapefile by clicking Add New Attribute.  
You will need to provide an Attribute Name, Data Type, Length, and 
Precision (number of decimal places).  If the shapefile contains multiple 
polygons, we recommend that you include an identifier as an attribute to 
keep track of the specific polygons.  Checking the Variable Change - 
Default Attributes box adds an identifier for individual polygons (fig. 4-24). 
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Figure 4-24. Selecting default attributes for Variable Change.   

 
 

Be sure to check the box to the left of the Attribute Name after adding all 
attributes.  Only those attributes that have been checked will be included 
in the shapefile.  Simply check or uncheck selections to add or remove 
them.   

 
Tip:  Using the “Data Type” drop-down menu allows you to choose a data 
type such as “Long Integer,” “String,” etc. (or you can accept the default 
values).  The “Length” field gives the expected number of characters in a 
string. The “Precision” field specifies the number of decimal places. The 
data format can be modified as needed.  Refer to ArcGIS Help for further 
information. 

 
4. Click Next when the dialog box is complete to open the Editor 

Toolbar and close the Area Change Tool dialog box.    
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4.5.3 Editing an existing shapefile 

 
1. Select the Edit Existing Shapefile radio button in the GIS Function 

box if you want to edit an existing shapefile rather than create a 
new shapefile from scratch (fig. 4-25).   

 

 
Figure 4-25. Use the Edit Existing Shapefile option to edit existing shapefiles. 

 
 

2. Click Next to open the Editor Toolbar (fig. 4-26), which can be used 
to add new polygons or to modify the shape of existing polygons.  
In addition, select this option if you need to edit the values of an 
exiting shapefile’s attribute table.   The Editor Toolbar used by ACT 
is exactly the same as the Editor Toolbar available in ArcMap.    

 

 
Figure 4-26. The Editor Toolbar. 
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Figure 4-27. Drop-down Editor menu. 

 
3. Click on the Editor drop-down list and select Start Editing, as 

shown in figure 4-27.  As before, you will need to identify the path 
that contains the target shapefile.  A Start Editing dialog box, which 
is used to select the appropriate path containing the shapefile to be 
edited, will appear (fig. 4-28).   

 

 
Figure 4-28. The Start Editing dialog box shows layers available for editing within the selected 
path. 
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4. After identifying the path, select an editing task from the Task drop-
down menu on the Editor Toolbar (fig. 4-29).   

 
 

 
Figure 4-29.  Selecting an editing Task from the Editor Toolbar. 

 
 

5. Select Create New Feature if your objective is to add polygons.  
Select Reshape Feature if your objective is to change the shape of 
existing polygons.  If your objective is to modify values in the 
attribute table, simply open the attribute table and change the 
values. 

 
6. Finally, you will need to select the appropriate shapefile from the 

Target drop-down menu on the Editor Toolbar (fig. 4-30). 
 

 
Figure 4-30. Use the Target drop-down menu on the Editor Toolbar to select an appropriate 
shapefile. 

 
 

7. Select the Sketch Tool icon (fig. 4-31) to begin drawing a polygon.  
Consult ArcMap’s Help utility to learn more about creating and 
editing polygons.  We recommend that you save edits frequently 
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(for example, after completing each polygon).  When you have 
finished editing, select Editor > Stop Editing > Save Edits. 

 

 
 
Figure 4-31. Editor Toolbar showing the Sketch Tool, Task (“Create New Feature”), and Target 
shapefile (“TreatmentC”). 

 
 

Tip:  If you happen to make a mistake in your drawing, it may be easier to 
delete the polygon and start over rather than trying to edit an existing 
polygon. 

 
8. Now you will need to provide the appropriate values for the 

attributes within the shapefile.  Open the attribute table of the 
shapefile you created by right clicking on the new shapefile in the 
ArcMap Table of Contents (fig. 4-32) and select Open Attribute 
Table. 

 
 

 
Figure 4-32. Example attribute table of a shapefile with four polygons and containing the following 
attributes: Id = polygon identifier, S-Class = succession class, FBFM = fire behavior fuel model, 
CC = canopy cover, CH = canopy height, CBH = canopy base height, and CBD = canopy bulk 
density. 

 
 

9. Enter the values that you wish to use in the appropriate cells of the 
attribute table.   

 
Note:  Be sure to press Enter after adding the last value and then close 
the attribute table before continuing. 
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10. When you are finished, save your edits by selecting Editor > Stop 
Editing > Save Edits.  Close the Editor Toolbar and the attribute 
table. 

 
Tip:  When you have finished editing, return to the Area Change Tool 
dialog box by clicking on the ACT Toolbar. 

 
 
 

 4.5.4 Converting shapefile attributes to rasters 

 
The next step in the Variable Change process is to convert the attributes 
of interest in a shapefile to new raster layers.  The GIS function Convert 
Shapefile Attributes to Rasters enables the user to convert each attribute 
of a shapefile to a new raster layer.  Select the radio button to the left of 
Convert Shapefile Attributes to Rasters and click Next (fig. 4-33). 

 
 

 
Figure 4-33. Converting shapefile attributes to rasters. 
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1. Click Next to open the following dialog box (fig. 4-34): 
 

 
Figure 4-34. Shapefile Attributes to Rasters dialog box.  In this example, the shapefile contains 
seven attributes: Id = polygon identifier, S-Class = succession class, FBFM = fire behavior fuel 
model, CC = canopy cover and CH = canopy height, CBH = canopy base height and CBD = 
canopy bulk density. 

 
 

Tip: The target shapefile must exist in ArcMap’s Table of Contents before 
attributes can be converted to new rasters. 

 
2. Select the shapefile containing the attributes to be converted to 

rasters from the drop-down menu near the top of the dialog box (fig. 
4-34).  Name each new raster by double-clicking in the box under 
New Raster Name and enter a name.  Once a new raster name has 
been entered, the box to the left of each attribute’s name is enabled 
and you can then check the attributes to convert.  Only attributes 
that are checked will be converted to a new raster. 

 
Note:  Remember that you do not need to add an extension, and the 
name is limited to eight characters or less.  In addition, the file name you 
select should not contain any spaces, leading numbers, or special 
characters (`~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 
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Tip:  You will not be able to check boxes in the “Shapefile Attributes” 
window until you double-click in the “New Raster Name” column and enter 
a name. 

 
3. When you have completed the dialog box, use the browse button to 

identify the path and folder for storing the new rasters.  Click Next 
to begin the conversion process.  The new raster layers will 
automatically be added to the ArcMap Table of Contents.  

 
Note: A progress bar located at the bottom of the dialog box indicates that 
conversion is proceeding.    

 
 

 4.5.5 Combining rasters 

 
Combining rasters is an effective technique for integrating multiple data 
layers at the pixel level.  When rasters are combined, each cell of the 
combined raster is assigned to one of the unique combinations of cell 
values from the input layers. The cell values of the input layers become 
attributes of the combined layer (see ArcGIS Help for a thorough 
discussion on combining raster layers).  

 
The maximum number of grids that can be input into the ArcGIS Combine 
function varies with hardware platform.  The combine function is also 
limited by the range of grid values in each layer.  No more than 10 million 
unique combinations are possible.  However, ArcGIS currently determines 
the number of potential combinations on the basis of maximum grid values 
in each of the layers to be combined.  For example, if a layer has two 
unique values with grid values of 100 and 101, then ArcGIS assumes that 
there are actually 101 unique values in that layer.  If this layer is combined 
with a similar layer, ArcGIS assumes that the combine function will result 
in 10,201 potential values even though in reality, there could be only four 
potential values representing the unique combinations of both layers. 

 
Tip:  If you receive an error message indicating that the “Combine” 
function will result in over 10 million unique combinations, you may be 
able to remedy the situation by: 

 
• Dropping one or more of the input layers, 
• Reclassifying the values of the input layers to decrease their 

maximum values, 
• Classifying the values of the input layers to reduce the number of 

potential combinations, or 
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• Combining the layers in stages.  For example, combine the first 
three layers in one step, the second three layers in another step, 
and then lastly combine the two combined layers.  

  
 

All input layers to be combined must be added to your ArcMap project 
before initiating the Combine function.  After adding all layers of interest to 
ArcMap, select the radio button to the left of Combine Rasters (fig. 4-35) 
and click the Next button to open the Combine Rasters dialog box. 
 

 
Figure 4-35. Selecting the Combine Rasters function. 

 
 

The Combine Rasters dialog box (fig. 4-36) is used to name the new 
combined layer, to order layers as they will appear in the Value Attribute 
Table, and to identify additional attributes from the input layers that should 
be included in the Value Attribute Table of the combined layer.  Complete 
the following: 

 
1. First, provide a name for the Combine Raster in the box labeled 

New Raster Name.  
 



Area Change Tool User’s Guide        Chapter 4 

 59

Note:  Remember that you do not need to add an extension, and the 
name is limited to eight characters or less.  In addition, the file name you 
select should not contain any spaces, leading numbers, or special 
characters (`~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 

 
2. Next, identify the rasters layers that are to be combined by placing 

a check in the box associated with any raster to be included.  The 
Rasters to Combine column includes any rasters that have been 
loaded into your ArcMap project.  The order in which rasters are 
checked will determine how they are arranged in the Value Attribute 
Table of the combined layer.  The column labeled Attrib Order 
automatically displays the sequence in which layers are checked.   
The last column in the dialog box, Join Attributes, adds any 
ancillary attributes, such as descriptive labels of a layer, into the 
Value Attribute Table of the combined layer.  To include an ancillary 
attribute, double-click on the appropriate cell and then check the 
boxes of the attributes to be included. 

 

 
Figure 4-36. The Combine Rasters dialog box. 

 
 

3. When you have completed the dialog box by identifying the rasters 
(Rasters to Combine), specifying the appropriate order (Attrib 
Order), and adding important ancillary attributes (Join Attributes), 
use the browse button to navigate to the folder in which you wish to 
use to store the combined layer.  You can accept the default path 
or choose a new location.   
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Click Next to create the new raster.   The new raster is automatically 
added to the Table of Contents in ArcMap.  Review the Value Attribute 
Table of the combined layer to ensure that the layer will meet your needs.  
The Value Attribute Table for this example is shown in figure 4-37. 

 

 
Figure 4-37. The attribute table of the combined layer showing the first of 2,491 records. 
 
 

 4.5.6 Editing raster attribute tables 

 
ACT provides two options for editing attribute tables of raster layers:  
Microsoft Excel or Access.  In many instances, the choice of software 
depends largely on your own experience level.  Although Excel may be 
easier to use, it can be more tedious and inappropriate for large editing 
projects.  Attribute tables of a combined layer commonly contain 
thousands of records, which may prove problematic when using Excel 
since Excel has a limit of 65,560 records.   Using Access is typically more 
efficient for large editing projects since queries can update hundreds of 
records simultaneously.   

 
If not already active, select the Edit Raster Attribute Table radio button 
in the Area Change Tool dialog box (fig. 4-38) and click Next to open the 
Edit Raster Manager dialog box (fig. 4-39). 

 
Tip:  ACT automatically advances to this dialog box after the Combine 
Rasters operation is finished. 
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Figure 4-38. Selecting the GIS function to edit a raster attribute table. 

 

 
Figure 4-39. The Edit Rasters Manager dialog box. 
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The Edit Rasters Manager dialog box (fig. 4-39) is used to transfer Value 
Attribute Tables to either Excel or Access for editing and subsequently to 
transfer the edited Excel/Access data to a Value Attribute Table of a new 
raster layer.  The upper portion of the Edit Rasters Manager dialog box 
pertains to Excel and the lower half to Access.   

 
 

Excel Transfer 
 

Part 1:  Transfer an attribute table to Excel  
 

Three steps are required to export an attribute table to an Excel 
spreadsheet for editing (fig. 4-40).   

 
1. First, identify the raster to be edited by clicking on the browse 

button to the right of the Raster box.   
 

2. Create an Excel spreadsheet by clicking on the browse button to 
the right of New Excel File. 

 
3. Lastly, export the raster attribute table to Excel by clicking on the 

large icon (Export a raster attribute table to Excel) at the right of the 
Excel Transfer Part 1 box.  During exporting, the record count of 
the raster will appear in the dialog box.  This feature is useful for 
determining if the raster has more than 65,560 records, which will 
exceed the capacity of Excel.  Excel opens automatically when 
exporting is complete (fig. 4-41).  

 
 

Tip:  If the record count exceeds the limit of Excel (65,560 records), a 
warning message appears and the Excel transfer will stop. 

 
Note:  A progress bar at the bottom of the dialog box indicates that the 
transfer is proceeding. Processing may take several minutes for rasters 
with large numbers of records and/or attributes.  
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Figure 4-40. Use the Edit Rasters Manager dialog box to export a raster attribute table to Excel. 

 
 

 
Figure 4-41. An Excel spreadsheet derived from the Value Attribute Table. 

 
Tips:: 

• Make a backup copy of the spreadsheet prior to changing any 
values.  If mistakes are made, an original copy will still be available. 

• Never change values in the ObjectID, Value, or Count fields of a 
combined raster.  Instead, edit only the attributes of that raster. 



Area Change Tool User’s Guide        Chapter 4 

 64

• Never delete any records. 
• Sort spreadsheets with care – data can be easily scrambled 

beyond repair.  Be sure to sort the entire spreadsheet and not just a 
subset of fields.  Always return the spreadsheet to its original form 
before transferring data to an attribute table by sorting the entire 
spreadsheet using the Value field. 

 
Use SaveAs to save your worksheet when edits are complete.  Close 
Excel and save your ArcMap project.  This will bring you back to the ACT 
Edit Raster dialog box. 

 
 
 

Part 2:  Transfer edited data in Excel to an attribute table 
 

This feature of ACT is used to create a new raster from the edited version 
of an Excel worksheet.  Open the Area Change Tool dialog box and select 
the Edit Raster Attribute Table radio button.  The following steps are 
required to import a spreadsheet into an attribute table (fig. 4-42). 

 
1. Identify the Excel spreadsheet that contains the edited data by 

clicking on the browse button to the right of the Excel file box.   
 

2. Identify the Original Raster that was used to create the Excel 
spreadsheet.  ACT will usually provide this information 
automatically, but make sure that this information is correct before 
continuing. 

 
3. Enter a name and path for the New Raster by clicking on the 

browse button to the right of the New Raster box.  Remember that 
the name is limited to eight characters or less.  In addition, the file 
name you select should not contain any spaces, leading numbers, 
or special characters (`~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 

 
4. Create the new raster by clicking on the large icon (Import an 

edited attribute table in Excel) at the far right of Excel Transfer, Part 
2.   

 
 

The new raster will be added automatically to the Table of Contents in 
ArcMap.  Save your ArcMap project. 
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Figure 4-42. Use the Edit Rasters Manager dialog box to create a new raster from an edited 
Excel spreadsheet. 

 
 

Access Transfer 
 

Part 1:  Transfer an attribute table to Access 
 

Open the Edit Rasters Manager dialog box by selecting the Edit Raster 
Attribute Table radio button.  The bottom portion of the Edit Rasters 
Manager dialog box pertains to using Access to edit the attribute table of 
an existing raster.  
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Exporting a Value Attribute Table to Access is a simple process (fig. 4-43). 
 

1. Identify the raster to be edited by clicking on the browse button to 
the right of the Raster box.   

 
2. Name the Access database by clicking on the browse button to the 

right of the New Access DB box. 
 

3. Click on the large icon to the far right of the Access Transfer, Part 1 
box to export the Value Attribute Table to an Access database.  
The Access database will open automatically when the transfer 
process is complete and contains a table with the same name as 
the database (fig. 4-44).  Open the table and begin editing. 

 
 

 
Figure 4-43. Use the Edit Rasters Manager dialog box to transfer a Value Attribute Table to an 
Access database. 
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Figure 4-44. An Access table derived from the Value Attribute Table. 

 
Tips:   

• Create a backup table before any changes are made.  If mistakes 
are made, an original copy will still be available. 

• Never change values within the “OBJECTID,” “Value,” or” Count” 
attributes of a combined raster.  Change data only in fields 
corresponding to layer attributes. 

• Never delete any records. 
• Save any updated queries used for editing.  Saved queries can be 

useful for identifying errors and for making consistent changes in 
subsequent editing sessions. 

 
 

Part 2:  Transfer edited data from Access to a value attribute table 
 

This feature is used to create a new raster from the edited version of an 
Access database table.  Open the Area Change Tool dialog box and then 
select the Edit Raster Attribute Table radio button to open the Edit Rasters 
Manager dialog box.  To import a database into an attribute table, 
complete the following steps (fig. 4-45). 

 
1. Select the Access database that contains the table to be converted 

to an attribute table.  Click on the browse button to the right of the 
Access DB box to navigate to your database.    

 
2. Select the appropriate table in the database by using the drop-

down menu to the right of the Access Table box. 
 

3. If necessary, identify the original raster layer using the browse 
button associated with Original Raster.   ACT will usually complete 
this step automatically once the Access table is identified.  
However, make sure that the Area Change Tool has identified the 
correct raster layer before proceeding. 

 
4. Identify a name and path for the new raster layer by clicking on the 

browse button to the right of the New Raster box.   Remember that 
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the name is limited to eight characters or less.  In addition, the file 
name you select should not contain any spaces, leading numbers, 
or special characters (`~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 

 
5. Create the new raster by clicking on the large icon labeled Import 

an edited raster attribute table from Access at the right of the dialog 
box.  The new raster containing the edited information will appear 
automatically in the ArcMap Table of Contents. 

 

 
Figure 4-45. Converting Access database table to a new raster layer. 

 
 

From the drop-down menu to the right of Access Table, select the table to 
import from Access.  If the original raster is located, its path and name will 
be displayed in the box to the right of Original Raster.  However, if it is not 
found, the browse button to the right of the box will be enabled, and you 
will need to use it to browse to the original raster.  Once a valid original 
raster has been entered, the browse button to the right of New Raster is 
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enabled.  Click on this icon and enter a name and path for your new 
raster.  Next, click on the large icon Import an edited raster attribute 
table from Access.  The new raster layer will be created and added to 
ArcMap’s Table of Contents.    

 
 

 4.5.7 Convert raster attributes to new rasters  

 
This ACT feature is used to create individual raster layers from the 
attributes of a combined layer.  Open the Area Change Tool dialog box 
and select the Convert Raster Attributes to Rasters radio button (fig. 4-
46) or click the Next button on the Edit Rasters dialog box.   

 
 

Tip:  The raster of interest must be present in your ArcMap project before 
raster attributes can be converted to new rasters. 

 

 
Figure 4-46. Converting raster attributes to raster layers. 

 
 

The Raster Attributes to Rasters dialog box will open (fig.4-47). 
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Figure 4-47. The Raster Fields to New Rasters dialog box is used to convert raster attributes to 
individual raster layers. 

 
 

The dialog box for converting raster attributes to raster layers (fig. 4-47) is 
used to identify the combined raster and attributes to be converted to 
individual layers.  To carry out this function, complete the following: 

 
1. Select a raster containing the attributes that you would like to 

convert to new raster layers (this will generally be a combined 
raster).   Use the drop-down menu to the right of Combine Raster 
Name to select the combined raster.  All attributes contained within 
the combined raster will then appear in the lower portion of the 
dialog box (fig. 4-48).    

 
2. Enter a New Raster Name in the appropriate cell of the second 

column that corresponds to the attribute of interest as shown in 
figure 4-48.   

 
Note:  Remember that the name is limited to eight characters or less.  In 
addition, the file name you select should not contain any spaces, leading 
numbers, or special characters (`~! @#$^()-+={ }[ ]|\?/:;”’< >,.). 

  
3. The remaining three columns of the dialog box (Raster, Join 

Raster, and Join Additional Attributes) are optional and can be used 
to join any additional attributes to the new raster layer.  Typically, 
these are ancillary attributes that are used for descriptive purposes, 
such as a descriptive name that corresponds to a particular raster 
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value.  These additional attributes are generally included in the 
combined layer or in a layer that was used to create the combined 
layer.  To join additional attributes to the new raster layer, double-
click in the cell under Raster.  Select the raster layer containing the 
appropriate attributes from the drop-down menu (fig. 4-48).  

 
Tip:  The raster must exist within your ArcMap project before it appears in 
the drop-down menu. 
 

4. Double-click in the cell under Join Attribute and select the 
appropriate field from the drop-down menu that will be used to join 
the attributes to the new raster layer. This entry must correspond to 
the value of the new raster layer (fig. 4-48).   

 
5. Double-click in the cell under Additional Attributes.  Select all 

attributes from the drop-down menu by putting a check in the box 
corresponding to the necessary attributes.   After entering all 
information for a particular row of the dialog box, return to the first 
column and check the box. 

 
Tip:  New raster layers will be created only for Raster Attributes that are 
checked. 
 

 
Figure 4-48. The Raster Fields to New Rasters dialog box.  In this example, a new raster named 
evtnew is created from the Ev_type_1 attribute from the Combine layer.  The new raster layer will 
include an attribute labeled Evt_name which originates from the raster layer “ ev_type_1.” 
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6. Next save your work by clicking on the browse button to the right of 
the Save Rasters to box (fig. 4-47).  You can select a new location 
or accept the default value that appears in the window.  Click Next 
to create the new rasters.  After processing is complete, the new 
raster layers will appear in ArcMap’s Table of Contents. 

 
 

 
 
 
 

 4.5.8 Merge edited rasters with original rasters 

 
The Merge Edited Rasters with Original Rasters function is used to create 
a new raster layer made up of edited and non-edited data.  In other words, 
the edited data is “burned into” the non-edited data.  For example, post-
burn data might be used to overwrite pre-burn data. 

 
Note:  The raster layers to be merged must exist in your ArcMap project 
before you can use this GIS function. 

 
1. Open the Area Change Tool dialog box and select the Merge 

Edited Rasters with Original Rasters radio button (fig. 4-49).    
 

Tip:  ACT automatically advances to this dialog box after the previous 
operation.  
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Figure 4-49. Use the Merge Edited Rasters with Original Rasters radio button to open the Merge 
Edited Rasters dialog box and merge rasters. 

 
2. Click Next to open the Merge Rasters dialog box (fig. 4-50). 
 

 
Figure 4-50.  The Merge Edited Rasters dialog box.  In this example, the edited raster name 
evtnew is merged with the original raster named ev_type_1 to produce a new raster named evtfnl. 
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3. Identify a raster that contains edited values from the Edited Raster 
column by double-clicking in the adjacent cell in the column labeled 
Edited Raster Attribute.  The Edited Raster Attribute column 
identifies the attribute that was edited; that is, it identifies the 
attribute that will be used to overwrite the attribute in the Target 
Raster.  Select the appropriate attribute contained within the Edited 
Raster box by using the associated drop-down menu.  

 
4. Identify the Target Raster layer from the drop-down menu by 

double-clicking in the cell in the Target Raster column.  The target 
raster is the layer that will be changed by “burning in” the values 
from the Edited Raster. 

 
5. Select the Target Raster Attribute from the target raster that will be 

changed by the Edited Raster.  Double-click the cell in the Target 
Raster column and select the appropriate attribute from the drop-
down menu.   

 
Tip:  Typically, “Target Raster Attributes” must match the “Edited Raster 
Attributes.” 

 
6. Enter a name in the Merged Raster Name column.   

 
Note:  Remember that the name is limited to eight characters or less.  In 
addition, the file name you select should not contain any spaces, leading 
numbers, or special characters (`~! @#$^()-+={ }[ ]|\?/:;”’< >,.).  Do not 
include an extension. 

 
7. After entering a Merged Raster Name, return to the first column and 

check the box associated with the Edited Rasters of interest.   
Complete the same process for each set of raster layers that you 
want to merge. 

 
8. Specify an output folder for storing the new raster layers by using 

the browse button to the right of the Save Rasters to box.  Navigate 
to the directory of your choice and create a new folder.   

 
9. Lastly, click Finish.  The new raster layers will appear automatically 

in the ArcMap Table of Contents. 
 

Save your ArcMap project at this time.  We recommend that you zoom in 
to those pixels with values that were changed during the editing process.  
Are the changes evident in each of the output layers?  Toggle back and 
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forth between the pre- and post-change raster layers to compare pixel 
values that should have changed (be sure to use identical legends). 

 
Tip:  The output from the Merge Rasters operation will not carry the 
descriptive attributes as the intermediary outputs have because there is no 
associated “Join” option. 
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Chapter 5: Troubleshooting ACT – 
Common Errors, Symptoms, and 
Solutions 
 
 
If ACT fails to produce a new raster layer, consider the following: 
 

Naming Conventions 
 

Remember that you do not need to add an extension, and the name is 
limited to eight characters or less.  In addition, the file name you select 
should not contain any spaces, leading numbers, or special characters (`~! 
@#$^()-+={ }[ ]|\?/:;”’< >,.). 

 
 

Output Path 
 

The total length of the output path is limited to 80 characters.  In addition, 
names of folders within the path cannot contain spaces or special 
characters (such as `~! @#$^()-+={ }[ ]|\?/:;”’< >, .). 

  
 
To report a bug, please contact helpdesk@niftt.gov. 
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